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Abstract
We propose a novel framework for cross-modal zero-shot learning (ZSL) in the context of sketch-based image retrieval (SBIR). Conventionally, the SBIR schema mainly considers simultaneous mappings among the two image
views and the semantic side information. Therefore, it is desirable to consider fine-grained classes mainly in the
sketch domain using highly discriminative and semantically rich feature space. However, the existing deep generative modelling based SBIR approaches majorly focus on bridging the gaps between the seen and unseen classes by
generating pseudo-unseen-class samples. Besides, violating the ZSL protocol by not utilizing any unseen-class information during training, such techniques do not pay explicit attention to modelling the discriminative nature of the
shared space. Also, we note that learning a unified feature space for both the multi-view visual data is a tedious task
considering the significant domain difference between sketches and the colour images. In this respect, as a remedy, we
introduce a novel framework for zero-shot SBIR. While we define a cross-modal triplet loss to ensure the discriminative nature of the shared space, an innovative cross-modal attention learning strategy is also proposed to guide feature
extraction from the image domain exploiting information from the respective sketch counterpart. In order to preserve
the semantic consistency of the shared space, we consider a graph CNN based module which propagates the semantic
class topology to the shared space. To ensure an improved response time during inference, we further explore the
possibility of representing the shared space in terms of hash-codes. Experimental results obtained on the benchmark
TU-Berlin and the Sketchy datasets confirm the superiority of CrossATNet in yielding the state-of-the-art results.
Keywords: Neural networks, Sketch-based image retrieval, Cross-modal retrieval, Deep-learning, Cross-attention
network, Cross-triplets

1. Introduction
The recent years have witnessed the accumulation of
a vast volume of data, thanks to the availability of different types of comparatively cost-effective sensors. As
a result, a given phenomenon can be realized in various
forms of representations, thus providing complementary
perspectives. Given the inherent distributions shift among
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varied data modalities, it is non-trivial to jointly analyze
them within the scope of the original data space. The
modelling of a shared embedding space is necessary for
multi-modal data projection, preferably in a discriminative manner. In this paper, we are particularly interested
in the task of cross-modal image retrieval. This task is
essential since the visual data can be acquired in different
ways; for example, colour image, depth image, contour
or sketch image, etc. As far as the potential applications
are concerned, retrieving depth from the concerned RGB
image [1] for path-planning in SLAM models is a sought-
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after problem in this regard.
Amongst others, the notion of Sketch-based image retrieval (SBIR) is nowadays prevalent since it is easy to
obtain a rough sketch drawing for any object type. The
mental target [2] or query sample can be drawn by any
user in the absence of image instances of some obsolete
classes. Beside, sketches are a highly symbolic and minimalistic representation of data. In particular, SBIR finds
prominent applications in forensic studies or police investigations. By definition, SBIR systems seek to retrieve
several related colour images for a given query sketch
image. Often it is easier to quickly draw a sketch instance of a query image than to find its actual data instance. The problem set is hugely demanding, primarily
since the sketch and colour images are inherently diverse
in appearance and content. While their spectral and textural properties characterize natural images, shape plays
the most crucial role in understanding the sketch images.
In the same light, recent studies [3] have shown that the
ImageNet-trained convolutional neural networks (CNNs)
have an inherent bias towards texture. Hence, such CNN
cannot be directly applied to extract meaningful features
from the sketch images. Instead, we need a sophisticated
model that is deemed to increase the shape bias to improve
the overall representation, given sketch images.
Typically, the existing cross-modal retrieval systems
(including SBIR) work in a supervised setting where the
same set of semantic categories are utilized during training and inference. However, given the diversity of the
real-world objects, the retrieval model trained on a given
set of classes should generalize well to previously unseen
categories with bare minimum side information. This
condition increases the challenge of this problem a notch
higher. On a different note, zero-shot learning (ZSL) has
recently been extensively explored in image recognition.
The ZSL models are generally trained on a given set of
seen classes. The system is required to properly categorize samples coming from an entirely non-overlapping
collection of unseen classes during the inference phase
(figure 1). In addition to the visual instances, semantic
class-prototypes (one per class) are available for both the
seen and unseen data. In this regard, the ZSL problem
can be devised as a many to one mapping problem from
the visual to the prototype space given the seen classes.
It can then be utilized as the mapping function for classifying the unseen class data. The ZSL paradigm can be

Figure 1: Overview of the proposed CrossATNet model which allows
a cross-modal data retrieval, by reducing the distances of each mode of
data from a shared embedding vector.

incorporated within the SBIR framework as well. However, it has to be ensured that the mapping functions from
both the visual modalities (colour and sketch images) to
the semantic space should be modelled appropriately.
Very recently, the ZSL based SBIR systems are developed mainly in conjunction with the deep generative models [4, 5]. In this technique, given a sketch sample, the
authors try to learn the corresponding class RGB image
by generating pseudo samples corresponding to the unseen class prototypes. This requires access to unseen class
samples during the training time. This fundamentally
violates the protocol of zero-shot learning. They pose
the ZSL-SBIR problem as a standard supervised learning
problem of deploying the notion of adversarial learning to
align the cross-modal visual space to the semantic space.
Also, adversarial training can be unstable if the min-max
problem is not intuitively designed. The pseudo unseen
sample generation technique may fail to generate unseen
samples which exactly overlap with the original unseen
data in some feature space. On the other hand, we are
keener on making the shared feature space discriminative,
learning relevant image features given the sketch data, and
avoiding domain dependence of the shared space. We
bridge the domain gap by imposing semantic consistency
by preserving the topology of the semantic labels in the
network. If such a space can be realized during training,
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we can expect the unseen test classes also to follow the
same and yield excellent results upon deployment in the
testing phase.
To alleviate these shortcomings, we propose an
encoder-decoder based deep representation learning strategy for zero-shot cross-modal retrieval problem. In the
proposed framework, we use sketch-anchored and imageanchored cross-modal triplets to align sketches and images in the semantic space. We also recommend a novel
cross-attention network wherein we use a sketch-guided
feature extraction strategy from images. This helps in
approximating the complicated image-sketch mappingfunction by enabling focus on specific parts of the input
image. To reduce the domain gap between the two modalities, we preserve the topography of the semantic labels in
the embedding space. This reduces the confusion of assigning incorrect attribute information to a cluster during
the inference phase. The semantic information is fed to
the network by forming a semantic topology graph and
injecting the graph convolution network (GCN) features
to the semantic vector. Finally, to incorporate a speedy
retrieval framework, we use a hashing function to convert
the shared feature space to ternary bits. This increases the
efficiency of the network. In the following, we summarize
the significant highlights of the proposed models:
1) We introduce a novel CrossATNet framework which
constructs a shared discriminative features space for efficient sketch-based image retrieval. 2) Some of the highlighting aspects of CrossATNet are, a) cross-triplet, b)
cross-attention, and c) ensuring semantic consistency. 3)
We consider both real-valued and hash-code based shared
space to analyze the trade-off between accuracy and retrieval time. 4) Results on Sketchy and TU Berlin are
promising, and the robustness of the model is tested with
several ablation studies.

tasks given its wide applications in different domains.
Most of these researches are based on image-text crossdomain retrieval [8]. There are also a few works in the
image to its depth retrieval [1], gaining its popularity primarily after the LiDAR point cloud data became available. Another attempt in this line has been for retrieving
image-speech cross-modal data [9]. Efforts for solving
SBIR has also gained motion after the sketchy database
came up. [10, 11, 12, 13] are a few of the notable works
in this line. However, it can be noted that all these algorithms were designed for SBIR, and not the vice versa.
Interestingly, many researchers have extended retrieval
techniques to irregular domains using graph convolution
networks [14, 15], and point-CNN based techniques [16].
Zero-shot learning (ZSL): Zero-shot learning is being able to solve a task, despite not having any training
example of that class, and just by using some semantic information. [17] provides a complete comprehensive study in the recent advances in zero-shot learning
problems. One of the early notable work was by [18].
The ZSL concept mainly gained attention from this work,
and since then, it has been studied extensively. In ZSL,
usually, some lateral information is required to transfer
the knowledge learned in the seen classes to the unseen
classes. Often, this lateral information is realized by visual semantic mappings [19]. People have also come up
with understanding the attribute mappings in a semantic
space, which can be manually defined [20], or by using
Word2Vec embeddings [21], or by using a sentence description [22]. Currently, the GAN based architecture
is the commonly used framework for ZSL. Here, given
an unseen sample and its prototype, the network generates a pseudo-unseen sample of a different mode of data
[23]. Presently, various detection and cross-modal retrieval frameworks are achieved, apart from the classification task in ZSL. [24] proposed a coordinated joint
multi-modal embedding space for audio-visual classifica2. Related Works
tion and retrieval of videos, using ZSL.
Considering the primary attention of our paper, we
To the best of our knowledge [5, 4, 21, 25] are presently
briefly discuss the relevant emerging works in image re- the state-of-the-art methodologies that exist in the literatrieval in-line with (i) cross-modal data and (ii) zero-shot ture for zero-shot SBIR. It may be noted that while [5, 21]
learning.
use a generative adversarial network (GAN) based apRetrieval from cross-modal data: Some of the early proach for this task, [4] use a graph-convolution network
works in data retrieval was done by [6, 7] in single modal for aligning sketches and images in the shared semantic
image retrieval. However, in recent times, the focus has space. The authors in [25] advocate the importance of doshifted to more challenging cross-modal data retrieval main adaptation by transferring the knowledge acquired
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from ImageNet to their sketch data to improve the model’s
transferability. In another study, [26] also came up with
a stacked adversarial-based network for ZSL SBIR. However, as of now, [21] and [25] remain the state-of-the-art
architecture in ZSL: SBIR, and hence have been used for
comparison.
We want to emphasize that our model is a robust crossmodal retrieval framework in contrast to the few existing
methods on sketch-based image retrieval. Furthermore,
It also encodes the image-based sketch retrieval information. Current works in SBIR [21, 25] exploit a generative framework which typically requires sketch samples
to learn the corresponding class RGB image by generating pseudo samples. This procedure requires access to unseen class samples during the training time. Therefore, it
fundamentally violates the protocol of zero-shot learning.
Our model is an encoder-decoder framework where we
use the concept of cross-triplets for aligning the imagesketch modality in the feature space. We also preserve
the topology of the semantic space using a minimallyconnected graph, which helps in bridging the domain gap
between the two modalities. We also introduce a novel
cross-attention framework to extract a sketch-guided feature extraction from images to handle the classes which
have highly-cluttered features.

modalities in the visual space and the semantic space. The
overall architecture of our proposed framework is shown
in terms of a block diagram in figure 2.
3.1. Overall CrossAT:Net Architecture
We use a two-stage training process as described below
to design our framework.
1. We first extract the primary level features from the
image and sketch instances by training modalityspecific classifiers.
2. Next, we carry out the training of the CrossAtNet
framework, which primarily consists of an encoderdecoder-based model to carry out the visual space
to semantic space mapping using a cross-attention
network.

To extract the primary level features for both the data
modalities, we perform transfer-learning from a standard
pre-trained network, trained on the Imagenet dataset. We
then fine-tune them as per our dataset and its classes for
both the modalities X s and Y s . Both the modality-specific
classifiers are trained separately to preserve the domainspecific information. For this purpose, we use the VGGNet and the ResNet pre-trained networks for the initial
weight-initialization for the subsequent stage on (X s and
Y s ), using the labels from Z s .
We initialize the second stage by the network weights
3. Methodology
obtained from stage I. We aim to learn the shared latent
Preliminaries: Let X and Y denote the two incoming in- space features of both the modalities trained. The model
put streams to the network corresponding to sketches and should be trained so well on the seen classes that they
images, respectively. Under this setup, we aim to retrieve perform equally well on unseen class instances when dethe top-k images from X/Y, given a query image from ployed during the inference phase. The latent shared feathe modality Y/X. For this purpose, we subdivide the tures space denoted as V should be designed in a way such
data into train and test classes, namely the seen and the that it data instances from X s and Y s under similar classes
unseen classes as defined previously in such a way that should be closely aligned to their corresponding semantic
X = {X s ∪ Xu }. Here s denotes the seen training classes information feature W s . The proposed framework has
and u denotes the unseen test classes, We impose the strict mainly four branches: visual encoders, semantic encoder,
constraint that X s ∩ Xu = ∅. Similarly, we also subdivide cross-attention network, and a decoder network. The arthe Y data into the seen and the unseen data classes. Let chitectures of these branches are described in the followus define the label set for the data classes as Z and the se- ing subsections.
mantic class prototypes for the same as W. The semantic
3.1.1. Visual Encoders:
prototypes are a unique description of each class.
The model is trained using only the seen instances,
For the visual data inputs from the streams X s and Y s
while the unseen instances are deployed during the in- we use encoder functions f x (θ x ) and fy (θy ), where θ x and
ference phase. In this work, we primarily aim to design θy are the learnable parameters for the sketch and the ima domain-agnostic mapping between the different data age data streams, respectively.
4

Figure 2: Overall pipeline of the proposed CrossATNet architecture for a zero-shot retrieval from a cross-modal database, by projecting the data
samples on a shared semantic space. The network uses cross-attention to extract sketch-guided features from images. The network is trained on the
seen classses by forming cross-triplets, and tested on unseen classes. With the help of the projection layer, retrieval from unseen class are possible.

most of the existing work, a distributed word-vector embedding vector is used for each class name. Most commonly, this is achieved by using the standard word2vec
encoding. The word2vec module is pre-trained on large
natural language databases, which leads to the preservation of the English language word topography in the semantic space. For example, the embedding vector for the
word cat should be closer to that of dog in the semantic
space, than it would be with that of Airplane. Figure 3 illustrates this preservation of the semantic topography within different words through an example. We
take the semantic encoding from two network branches,
i) word2vec encoding, and ii) semantic-topography graph
preservation. For the latter part, we create a minimallyconnected graph of the nearest topographic classes and
use a graph-convolution network to propagate this infor3.1.2. Semantic Encoders:
mation onto the latent shared space. Preserving the topolThe semantic information is a unique description of ogy of the classes in the network helps in reducing the
each class label. So the total number of different semantic domain-gap between the different modalities by aligning
vector presents would be the number of training classes. the classes of the two domains in a similar way. The
We encode the semantic information similar to the visual encoder function fw (θw ) has a series of fully-connected
encoder part by using the mapping function fw (θw ), where layers, which basically encodes the projections from the
θw is its corresponding set of learnable parameters. In word2vec module and the graph module together in the

To extract the image features, we use a sketch-guided
cross-attention network. To realize this, the input weights
received from the stage I from the sketch module X is
branched, with one branch fed to the encoding function
f x (θ x ), and the other branch is connected to the crossattention branch (encoded by fatt (θatt )). Again, θatt here is
the learnable parameters for this set of encoding. For realizing the cross-attention network, we take the inputs from
stage I and use a global-average pooling layer.
This is then followed by 2-layers of fully-connected layers. The output of this is finally passed through a Sigmoid
function. This entire architecture constitutes the crossattention network module. The output of this encoder is
then directly multiplied with the output from the image
encoder ( fy (θy )).
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class. Hence, given the feature encoding of one stream,
we can reconstruct the encoding of the complimentary
stream. The decoder network effectively acts as a regularizer function and helps in achieving domain invariance
in the shared latent space.
3.2. Hashing
The shared space that has been realized is real-valued.
This requires Euclidean distance measures for searching
during the inference phase. If we transform the shared
features into a ternary space, we can use hamming distance measures for speedy retrieval. The performance of
a model is predominantly dependant on two things: accuracy and efficiency. While it is crucial to improve the
accuracy of a model, we should not completely ignore the
efficiency aspect. Hence in this regard, we add a hashing
module that encodes the embedding space into ternary bit
strings, which comprises of -1, 0, and 1. This helps in
attaining a higher efficiency of the model as the comparisons can be performed by using simple XOR operations
during retrieval. We use the standard Signum function,
as defined in equation 1 for hashing, where X is the concerned modality of the input data stream. We denote the
learned transformations in this step as Wt . We refer to this
learned shared space, subjected to the hashing function
as H. The hashing function hence transforms the shared
feature space from V to H.

Figure 3: A hierarchy-graph structure by constructing minimum spanning tree of the Word2Vec features of the labels.

semantic space.
However, it is not ensured whether this semantic information is directly propagated in the shared latent space
given the non-linear mappings performed at each neuron.
This is a severe obstacle in ZSL where the unseen samples
are mapped trivially in the latent space, considering that
i) model is trained only on the seen classes, ii) there is
significant distributions difference between the seen and
unseen visual samples. Hence, we consider the following
two different design protocols for the semantic branch.
• The semantic encoder is defined as a series of fullyconnected layers to project the seen class prototypes
W s onto the shared feature space. However, in this
case, the original semantic space topology may not
be preserved in the latent space.

• We use the word2vec features along with the graph
H = S X = sgn(Wt × fX (X))
(1)
G, encoding the neighborhood topology of Z s , to
form the semantic vector W s . We use a graph con- 3.3. Objective Function
volution network (with graph convolution and graph
In order to realize the latent space H, we introduce the
pooling layers) to encode G, and a fully-connected
following
loss functions to the network.
layer to fuse the word2vec and graph features to form
s
a)
Cross-modal
latent loss (Lcmd ): It is desirable to get
the semantic vector W .
the visual encoding of both the data streams adjacent in
the shared feature space by projecting them onto a com3.1.3. Cross-modal reconstruction networks
mon entity. To achieve this, we reduce the distance beWe use two reconstruction branches which reconstruct tween the visual encoding of both the data of the same
the cross-modal data instances from a given modal data. class (xis , yis ) to the semantic vector encoding of the same
We define this decoding network with the decoder func- class wis . We reduce the distance by minimizing the meantions g xy (θ xy ) and gyx (θyx ). When we provide the fea- square error (MSE) between them. This procedure mainly
ture embedding of the sketch data, i.e f x (Xcs ) and en- helps in bringing down the cross-modal intra-class varicode it using the decoder network g xy ( f x (Xcs )), we get ance. We define this loss function as,
the feature embedding of the corresponding label image
data instance, fy (Ycs ). Here, c denotes a particular label
Lcmd = || f x (Xcs ) − fw (Wcs )||2F +|| fy (Ycs ) − fw (Wcs )||2F (2)
6

Here, F represents the Frobenious norm, defined as the
square root of the sum of the absolute squares of the matrix elements.
b) Cross-triplet loss (Liii ): We add a cross-triplet loss
to reduce the intra-modal distances while increasing the
inter-class distances in the shared feature space. To extend this loss to a cross-modal setup, we use two types
of triads. One set of triads are constructed by taking an
image as an anchor and using the same class sketch instance and a different class sketch instance. This scheme
is described by the equation 3. The other set of triads are
formed by taking a sketch instance as an anchor and its
same corresponding class and other class image instance
along with it. This set of triads are described by equation 4.

 




L3a = max d(f y Ycs , f x Xcs ) − d(f y Ycs , f x X̃cs ) + α, 0
(3) 



  
L3b = max d(f x Xcs , f y Ycs ) − d(f x Xcs , f y Ỹcs ) + α, 0
(4)
Here, we use Ỹcs to denote a seen image instance of any
class other than c and d() to denote the Euclidean distance
between any two vectors. α denotes the heuristically chosen margin value, which pushes apart the different classes
beyond that minimum distance. The image-anchored L3a
loss and the sketch-anchored L3b loss together comprises
of the cross-triplet loss Liii .
c) Decoder loss (Ldl ): To make the shared features
domain-agnostic, we use a decoder loss in the reconstruction sub-branch of the network. To achieve this, we take
the visual encoding of a data instance from a particular
modality and reconstruct the visual encoding of instances
from the alternate modality (of the same class c). This
helps us in achieving domain-invariance in the shared feature space as we taper their distribution-gap. The idea is
to make the out of the decoder function g xy ( f x (Xcs )) nearequal to fy (Ycs ) (similarly for the other decoder function),
hence reducing the distribution-gap between the different
modalities. The sketch and the image data vary considerably in the visual feature space due to the absence of texture information in sketches. This loss helps in class-wise
aligning the two different modalities better in the decoder
space. The loss function is defined in equation 5.

Classification loss (Lce ): Finally, to make the shared feature space sufficiently discriminative for both the modalities, we inject the class information. This helps in increasing the inter-class distances in the visual encoding space.
We use the standard cross-entropy function as defined in
equation 6. We take the cross-entropy loss of the hashed
encoding to make the hashed space sufficiently discriminative.
Lce = CE (S A ) + CE (S B )
(6)
The overall objective function is the weighted sum of
all the loss functions, as mentioned above. The weights
act as momentum in the network. The final objective
function for our proposed framework is given in equation 7.
L = λ1 Lcmd + λ2 Ldl + λ3 Liii + λ4 Lce

(7)

The presence of multiple loss functions transforms the
problem into a non-convex optimization problem. However, when each loss is considered individually for the optimization while keeping all the other losses constant, the
problems transform back to a convex optimization problem for that loss. Likewise, if we iteratively perform an
iterative-shrinkage gradient descent for each loss individually, the network can be trained efficiently.
3.4. Inference
Cross-modal retrieval: Once the network is trained, we
get the shared feature space H. To find the top-k retrieved
data instances of a query q, we first find its representation
in the shared embedding space and search for its k-nearest
neighbour (k-NN) feature instances using Euclidean or
Hamming distance, depending on the variant of our architecture. These are the top-k retrieved data instances.
For a query xiu from X, we find the top-k retrieved data
instances from Y, and vice versa.
Unimodal retrieval: Likewise, for a query xiu from X,
we find the top-k retrieved data instances from X, and vice
versa. The overall framework of the proposed architecture
is demonstrated in algorithm 1.
4. Experiments
Datasets:
We validate our model by performing
the experiments on two standard benchmark datasets:
Sketchy [27] and TU-Berlin [28] dataset.

Ldl = ||g xy ( f x (Xcs )) − fy (Ycs )||2F +||gY X ( fy (Ycs )) − f x (Xcs )||2F
(5)
7

Algorithm 1 The proposed training and inference stage
Input: {X s , Y s , W s , Z s }
Output: Unified representations H.
1: Stage 1: Normalize and pre-train X s and Y s .
2: Stage 2: Find the Word2Vec embeddings of Z s .
3: Construct a topography graph G and generate W s .
4: do

network on three different pre-trained models, we report
the final performance with the VGG-16 model to maintain
fairness in the comparative study with the literature. The
pre-trained network yields a 2048-d vector. We train the
system using a momentum optimizer as it helps to accelerate SGD in the relevant direction and dampens oscillations. We choose a learning rate of 0.001 heuristically.
To train the Stage II of our network, we train the se5:
min λ1 Lcmd + λ2 Ldl + λ3 Liii + λ4 Lce (8) mantic encoder first. For the text-based model, we extract
θ x ,θy ,θ xy ,θyx
the 300-d word2vec features of the label names of the
datasets. For the graph-based model, we created a |Y s |
6: while until loss convergence
dimensional distance matrix. The distance matrix was
7: return S X and S Y (Projection from H)
constructed by finding the Euclidean distances between
Input: xiu ∈ Xu or yui ∈ Yu and Wu
the Word2Vec embedding of each class. A hierarchyOutput: Top-K retrieved data.
graph was constructed by taking the minimum spanning
8: Cross-modal zero-shot retrieval using k-NN.
tree (MST) of this edge matrix. After obtaining the graph
structure, we performed one layer of graph convolution.
An auto-encoder was then used to combine the graphThe Sketchy dataset [27] is a collection of a large based and the text-based models and construct a powerful
number of sketches and images of the same class labels. reduct, capable enough of having a discriminative knowlEach image/sketch instance has multiple corresponding edge power (i.e., fw ()). The auto-encoder is designed to
sketches/images. There are 125 different classes. Each bring down the dimension of the feature vector to 64.
class has 100 images, making it a total of 12,500 images.
To realize the visual encoder part of our network, we
Similarly, for the sketches, there are multiple sketchers for use a series of convolution neural network layers, foleach image. So the number of sketches vary in each class. lowed by a fully-connected layer for both f x () and fy ().
There are a total of 75,471 sketches distributed over 125 For the cross-attention module, we branch out a network
categories. For our ZSL framework, we randomly select from the sketch encoder and subject it to a global average
25 classes as the unseen classes for the inference phase pooling layer. This is then followed by two consecutive
and use the rest for the training purpose as the training fully-connected layers and a sigmoid function to mask
dataset.
out the attention part. We then take the scalar product of
Similarly, the TU-Berlin dataset [28] also has multiple this output and the visual encoding from the image branch
unpaired sketch and image instances. There are a total fy (θy ) and use that as the new fy (θy ).
of 250 classes in this dataset. Eight hundred images in
For the decoder part, we use a single fully-connected
each class and a variable number of sketches per class. layer placed after the last layer of the visual encoders.
The total number of sketch instances over 250 classes is We put a batch normalization layer after the CNN lay204,489. For our ZSL framework, we randomly select ers and a drop out layer after the fully connected layers.
30 classes as the unseen classes for the inference phase We have also induced non-linearity into the network by
and use the remaining 220 for the training purpose as the placing leaky˙ReLU() layers after the drop-out functions.
training dataset.
For the second stage, we use an Adam optimizer to miniModel Architecture: To train the stage I of our network, mize the loss function using a stochastic gradient descent
we use the standard VGG-16, ResNet-50, and ResNet- procedure. Again, the learning rate is heuristically chosen
101 pre-trained model and transfer the knowledge to our as 0.001. The model was trained by setting the α value as
dataset. The model is then fine-tuned by minimizing a 1 (equation 3) and a batch size of 256 for 200 epochs.
cross-entropy loss function to boost the descriptiveness of Training and Evaluation Protocol: We train the network
the features. These weights are then used for the initial- by selecting random images and sketches and forming
ization of stage II. While we test the performance of our their corresponding triads. We train the network by ap8

Table 1: Performance of the proposed CrossATNet framework for sketch-based image retrieval on the Sketchy and
represents the algorithms that have a hashed vector-representation.
Task
Sketchy
TU-Berlin
mAP
P@100
mAP
P@100
Siamese CNN [29]
0.183
0.143
0.153
0.122
SaN [30]
0.129
0.104
0.112
0.096
SBIR
3D Shape [31]
0.070
0.062
0.063
0.057
DSH (Binary) † [28]
0.171
0.231
0.129
0.189
GN Triplet [27]
0.204
0.296
0.175
0.253
SSE [32]
0.154
0.108
0.133
0.096
JLSE [11]
0.131
0.185
0.109
0.155
ZSL
ZSH [12]
0.159
0.214
0.141
0.177
SAE [13]
0.216
0.293
0.167
0.221
ZS-SBIR [5]
0.196
0.284
0.005
0.001
EMS [33]
0.259
0.369
ZSL:SBIR
CVAE [5]
0.225
0.333
SEM-PCYC [21]
0.349
0.463
0.297
0.426
SAKE [25] a
0.547
0.692
0.475
0.599
CrossATNet
0.413
0.487
0.327
0.427
ZSIH † [4]
0.258
0.342
0.223
0.294
Hashed ZSL:SBIR
EMS † [33]
0.165
0.252
SEM-PCYC† [21]
0.344
0.399
0.293
0.392
SAKE [25]† 0
0.364
0.487
0.359
0.481
CrossATNet †
0.365
0.411
0.316
0.404

TU-Berlin dataset. Here, †
Size
64
512
64
64 †
1024
100
220
64
300
1024
512
4096
64
64
64
64†
64†
64†
512 †
64†

a SAKE uses the ImageNet data as auxiliary information during the training process which greatly helps in boosting up the performance of the network. Hence, direct
comparison with this framework is not fair. Further details are given in the discussion section.

proximately using 2,00,000 sketch-anchored and imageanchored triads. To avoid any training bias due to imbalance number of samples in the two modalities, we
feed an equal number of triads of both types in each
batch. To evaluate the performance of our model, we
use the standard mean Average Precision (mAP) value
and the P@100 (precision for top-100) scores and follow the training and evaluation protocol of [21]. For the
ZSL:SBIR part, we use just the sketch-anchored triplets to
have a fair comparison with the state-of-the-art methodologies. Such training boosts the SBIR part of the performance of our network. For the cross-modal retrieval
part, we train the model with both the sketch-anchored
and image-anchored cross triplets.

Table 2: Performance of the proposed CrossATNet framework for crossmodal retrieval on the Sketchy and TU-Berlin datasets in terms of mAP
and precision at top-100 (P@100) values. Here, † represents the algorithms that have a hashed vector-representation.

Task
Sketch→Image
Sketch→Image †
Image→Sketch
Sketch→Sketch
Image→Image

Sketchy
mAP P@100
0.372 0.430
0.347 0.410
0.359 0.312
0.318 0.343
0.561 0.594

TU-Berlin
mAP P@100
0.302 0.322
0.312 0.376
0.289 0.298
0.238 0.257
0.465 0.466

Sketchy dataset. The current state-of-the-artwork in literature closest to our work is given in [21, 25]. We also
show a few more comparison with [29, 30, 31, 28, 10, 27,
32, 11, 12, 13, 5, 33, 4]. Here, † represents the algorithms
that have a hashed vector-representation. We report the
performance of our model for both cross-modal and unimodal retrieval in table 2.
For the non-hashing case, SAKE exceeds the perfor-

5. Discussions
The train and test classes were chosen randomly for the
experiments to avoid any bias induced while training. Table 1 shows the comparison of the performance of various
models present in the literature on the TU-Berlin and the
9

mance of CrossAtNet for the majority of the cases, while
for hashing case, the results are almost comparable. However, our framework can exceed the performance of all
the generative ZSL:SBIR and the majority of discriminative ZS-SBIR approaches. It is visible that while for
the non-hashing case, SAKE gets the better of CrossAtNet for the majority of the cases and for the hashing case,
we outperform SAKE on the Sketchy dataset. The significant distinctions between SAKE and other zero-shot
SBIR frameworks that are responsible for the success of
SAKE are (i) SAKE uses the entire ImageNet data as
auxiliary information during training to combat the catastrophic forgetting, which greatly helps in generalization to
unseen-class samples in ZS-SBIR. Precisely, SAKE uses
the rich semantic space of Imagenet and deploys a domain adaptation paradigm to ensure that the sketch-image
data in ZS-SBIR comply with the semantic topology of
Imagenet. However, this additional information is seldom used in the zero-shot learning literature [21], and we
also have not used the same in CrossAtNet. (ii) SAKE
uses a conditional auto-encoder based shared feature extractor coupled with ResNet-50 (CSE-ResNet50) for the
sketches and photos. This definitely contributes to boosting the performance of SAKE. In spite of this, we see that
standard VGG-16 based CrossAtNet achieves superior results to the literature and even outperforms SAKE in a few
cases.
The framework not only encodes the SBIR mapping,
but it also encodes the inverse IBSR mappings. Table 2
how well the proposed framework can retrieve images
from sketches, sketches from images, images from images, and sketches from sketches. Fig. 4 shows a few examples of the top-5 retrieved images, given a query image
(first column). The two primary purposes of our framework were to make the shared feature space discriminative and to reduce the domain-gap between the two modalities. Fig. 6 (a) and (b) shows the t-SNE plots of five random classes from the shared features of the images and
features, respectively. It can be seen that the designed
features space is discriminative. Fig. 6 (c) shows the overlapped scatter plots of the two modalities to highlight how
overlapping the feature space is. The image features are
presented by crosses, while the sketch features are shown
by dots.
While performing the experiments, we observed that
there is much confusion between very closely related

Figure 4: Top retrieved results of zero-shot cross-modal retrieval
on the unseen classes. Alternate rows represent Sketch→Image and
Image→Sketch retrievals.

Duck

Swan

Chicken

Penguin

Owl

Elephant

Squirrel

Airplane

Rabbit

Pig

Figure 5: Few examples from confusion classes are represented in the
first row. The second row shows some idiosyncratic sketches.

classes, like Swan, Duck, Owl, and Chicken. The first
row of Fig. 5 shows a few instances from these classes.
Upon close examination, we could observe that while
the photos of these classes were well distinguishable, the
sketches were tough to be recognized even with human
evaluation. The main feature distinguishing them is the
texture and colour properties, which obviously cannot be
represented in sketches. Also, we noticed that there were
several idiosyncratically drawn sketches like shown in the
second row of Fig. 5. There were multiple instances in
each class, which just had “press reset” written in it. Another interesting observation that we made during the critical analysis of the results was retrieving uni-modal photos was achieved with much higher precision than retrieving the uni-modal sketches. We presume that this is possibly due to the lack of highly informative texture data
field.
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Table 3: Sensitivity analysis of the hyper-parameters for the final objective function by varying the values of the λi , ranging from 0.01 to 1. The
results are reported in terms of the mAP values for the Sketchy dataset.

Values
0.01
0.1
1
(a) Images

λ1
0.36
0.41
0.11

λ2
0.37
0.41
0.19

λ3
0.32
0.29
0.41

λ4
0.41
0.39
0.38

(b) Sketches

(c) Images and Sketches
Figure 6: Two-dimensional t-SNE scatter plots of the shared feature
space of images, sketches, and both of them together for five random
unseen classes. The different colors represent the embeddings of different classes. The image embeddings are plotted by hashes, while the
sketch embeddings are plotted by dots.

Hyper-parameter tuning of equation 7 (λ1 , λ2 , λ3 , and
λ4 ): We followed the standard procedure of the ZSL community by splitting the training data into (pseudo-seen and
pseudo-unseen) for the purpose of cross-validating the parameters in equation 7. The network performance under
these hyper-parameter settings in terms of mAP values on
the Sketchy dataset is shown in table 3. We experiment the
performance of the network by choosing different values
of λ ranging from 0.01 to 1. We choose the parameters λ1
to λ4 after cross-validation. A sensitivity analysis on the
parameters is shown in Table 3. We choose the combination of hyper-parameters that yield the best performance
in the final model.
5.1. Ablation Studies
Effect of Graph-based model: To investigate the contribution of graph structure in preserving the hierarchy of
the labels in the semantic space, we study the performance
of the proposed model with and without using the graph
structure. We get the projection layer values just from
the Word2Vec embeddings, followed by a set of autoencoders to bring down the dimension of the projection
11

vector. The leverage of preserving the hierarchy information of the labels can be seen from Table 4.
Effect of decoder loss (Lrcs ): The decoder loss was introduced in the model to achieve domain-independence between X and Y. This loss reconstructs the feature embedding of the alternate modality from the shared-embedding
of a given modality of data. Minimizing the decoder loss
in addition to the overall loss function boosts the performance of the framework significantly. A definite fall in
the performance of the network can be seen in table 4,
without the decoder loss.
Effect of cross-triplet loss (L3lt ): The cross-triplet was
added to the network to bring the same class samples of
different modalities nearby, while pushing the different
classes of different modalities far apart in the embedding
space. While performing a gradient descent on this loss
function we can see a clear boost in the performance of
this model from table 4.
Effect of fixed/latent semantic space: To study the adequacy of the semantic space, we conduct two set of experiments. Firstly, we train the model with the Word2Vec
features as the fixed semantic vector. In the second set of
experiments, we keep this vector learnable and learn the
optimum 300-d semantic vector using the Word2Vec and
a graph hierarchy during the training process. It can be
seen from table 4 how the latent semantic vector outperforms the fixed projection vector.
Effect of Pre-training: To investigate the effect of bias
introduced in the model due to the pre-training network,
we perform our experiments using three different pretrained models VGG-16, ResNet-50, and ResNet-101. It
can be seen from table 4 that a ResNet-50 trained model
outperforms the VGG-16 trained model, while ResNet101 on the other hand performs a little inferior to ResNet50 in the Sketchy dataset. For the TU-Berlin data, VGG16

the-art models which exploit the standard protocol of a
ZSL:SBIR framework. We also outperform the SAKE
framework in a few cases, wherein the authors make use
of auxiliary datasets to boost up their network performances considerably. The foremost essence is to dedim
sign the shared embedding space sufficiently class-wise
64
discriminative enough and adequately domain-wise in64
64 variant. We can extend the framework to form a self64 supervised architecture or explore the possibility of ex300 tending it to an incremental learning framework.

Table 4: Ablation study (with mAP values) with different experimental
setups to analyze the effect of each of these dependencies on the proposed model.

Task
Total model
Without Graph
Without decoder loss Lrcs
Without triplet loss L3lt
Fixed semantic space
Pretraining with VGG-16
Pretraining with ResNet-50
Pretraining with ResNet-101
Seen+Unseen class graph

Sketchy
0.413
0.386
0.215
0.198
0.243
0.413
0.421
0.398
0.422

TU-Berlin
0.327
0.311
0.178
0.217
0.1987
0.327
0.325
0.309
0.331

64
64
64
64
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